


Preface

ATLAS.ti Quick Tour











About this Quick Tour

Video Tutorial: Overview of ATLAS.ti 22 Windows

Useful Resources for Getting Started

ATLAS.ti Academy

https://youtu.be/NIO4Kca_l-4
https://atlasti.com/trainings/


ATLAS.ti Account and Licence Activation

Multi-User License Management Guide for License

Holders & Administrators

Requesting a Trial Version

Trial Desktop

My Applications

Activating a Licence

https://atlasti.com/institutions/atlas-ti-license-management/
https://atlasti.com/institutions/atlas-ti-license-management/
https://atlasti.com/institutions/atlas-ti-license-management/
https://atlasti.com/institutions/atlas-ti-license-management/


Activate License.

Check For Updated License

Accessing Your Account from within ATLAS.ti



Manage Account



Logging Out

Log Out and Restart

https://my.atlasti.com/

Log Out

Working Off-Line

off-line

Options



Limited Version after Licence Expiration

Restrictions of the Limited Version





Introduction

Video Tutorial: Overview of ATLAS.ti 22 Windows

The VISE Principle

VISE

Visualization

https://youtu.be/NIO4Kca_l-4


Immersion

Serendipity

a seeming gift for making fortunate discoveries

accidentally

serendipity

browsing



Exploration

bureaucratic

Areas of Application

soft data



contextuality



ATLAS.ti - The Knowledge Workbench

knowledge workbench

Some Basic Terms

container

ATLAS.ti project

source data

copied

Project Cloud

text documents

images audio recordings

video clips PDF files

geo data

social network comments

coding

codes

marking annotating

paper and pencil paradigm



margin area

General Steps when Working with ATLAS.ti

Creating a New Project

Adding Documents

Working With Groups

Working With Comments And Memos Coding Data - Basic Concepts

Retrieving Coded Data

Data Analysis Data

Export For Further Statistical Analysis

Working With Networks

Working With

Comments And Memos Exporting Networks

The ATLAS.ti Research Blog The

ATLAS.ti conference proceedings

https://doc.atlasti.com/ManualWin/Memos/MemosAndComments.html
https://doc.atlasti.com/ManualWin/Querying/QueryingData.html
https://doc.atlasti.com/ManualWin/Export/ExportForFurtherStatisticalAnalysis.html
https://doc.atlasti.com/ManualWin/Export/ExportForFurtherStatisticalAnalysis.html
https://doc.atlasti.com/ManualWin/Memos/MemosAndComments.html
https://doc.atlasti.com/ManualWin/Memos/MemosAndComments.html
https://doc.atlasti.com/ManualWin/Networks/NetworksExporting.html
https://atlasti.com/research-hub
https://depositonce.tu-berlin.de/bitstream/11303/5404/3/ATLASti_proceedings_2015.pdf
https://depositonce.tu-berlin.de/bitstream/11303/5404/3/ATLASti_proceedings_2015.pdf


Main Steps in Working with ATLAS.ti

Data and Project Management

Supported File Formats

Project Management

Team Work

Two Principal Modes of Working

https://doc.atlasti.com/ManualWin/Project/ProjectManagement.html
https://doc.atlasti.com/ManualWin/Team/TeamWork.html


Data Level Work

Exploring Data

quotations

note-making/annotating hyperlinking

search retrieval, and browsing functions

Conceptual Level Work

https://doc.atlasti.com/ManualWin/Exploring/ExploringTextData.html
https://doc.atlasti.com/ManualWin/Quotations/QuotationsTextCreating.html
https://doc.atlasti.com/ManualWin/Memos/MemosAndComments.html
https://doc.atlasti.com/ManualWin/Hyperlinks/HyperlinksWorkingWith.html
https://doc.atlasti.com/ManualWin/Quotations/QuotationReader.html


Querying Data Working With Networks

https://doc.atlasti.com/ManualWin/Querying/QueryingData.html


Creating a New Project

Video Tutorial: Creating a project and adding data

Create New Project

https://youtu.be/ikoGSmpkb4I




Create

File > New Create New

Project

Create



Supported File Formats

Textual Documents

Format File Type

Multimedia Transcripts

Transcripts

Transcription

PDF files (Text and Graphic)

https://doc.atlasti.com/ManualWin/Transcription/Transcription.html


PDF with annotations / Word files with comments

Imported comments

Imported annotations

PDF documents with annotations imported in ATLAS.ti



Word document with comments

Immporting a codebook

https://doc.atlasti.com/ManualWin/Codes/CodeImportExportCodeList.html


PDF files with bookmarks



View Show

Bookmarks

PDF files (eBooks, PowerPoint, Spreadsheets, Visio, Draw)



Images

Size recommendation:

Audio- and Video Documents

available here

Adding Documents

Geo Documents

Query Address

Working With Geo Docs

Social Network Comments

exportcomments.com

https://msdn.microsoft.com/en-us/library/windows/desktop/dd757927(v=vs.85).aspx
file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/Documents/DocumentTypeGeoWorkingWith.html
https://exportcomments.com/


Importing Social Network Data

Survey Data

Working With Survey Data

Reference Manager Data

Literature Review

Working With Reference Manager Data.

Evernote

Bring out the best in Evernote with ATLAS.ti Windows

Evernote Export File Type

file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/Documents/DocumentTypeSocialMediaComment.html
file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/Documents/DocumentTypeSurveyDataIntro.html
file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/Documents/DocumentTypeReferenceManagerData.html
https://atlasti.com/research-hub/evernote-with-atlas-ti-windows


Adding Documents

Video Tutorial: Creating a project and adding data

What happens when you add documents to a project

When you add documents to a project, they are stamped with a unique ID.

What happens when you add documents to a project

add

Important for team projects

all entities are stamped with a unique ID when they are created.

merge duplicated codes

Team Work

https://youtu.be/ikoGSmpkb4I
https://doc.atlasti.com/ManualWin/Team/TeamWork.html


How to add documents

Add Documents Home

Linking video files

Repair Link

Document Manager > Tools Tab

https://doc.atlasti.com/ManualWin/Managers/ManagersForDocuments.html


import iranscripts Importing Transcripts

prepare your own transcripts

Sort Order of Documents

User-defined document sort order

Size Restrictions

A Word about "Big Data"

https://doc.atlasti.com/ManualWin/Transcription/ImportingTranscripts.html
https://doc.atlasti.com/ManualWin/Transcription/PreparingOwnTranscripts.html
https://doc.atlasti.com/ManualWin/Documents/DocumentsManaging.html




Importing an Existing Project

Version File Type

How to Import Projects

Import Project

File > New Import Project

Options



If the project contains Linked Media Files





Project Cloud

privacy policy

Your project will

stay safely on your computer until you decide otherwise.

https://atlasti.com/legal/privacy-policy


On this computer

In the cloud

Both on this computer and in the cloud

How to use



Sharing Projects

Team Work

Current limitations

https://doc.atlasti.com/ManualWin/Team/TeamWork.html


Creating a Project Backup

export

ATLAS.ti Project Cloud

project bundle file

transfer projects

Project Transfer

Exporting a Project

File > Export

file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/Project/ProjectManagementTransfer.html


Project Bundle

Exporting partial bundle files

project name (user name YYYY-MM-DD)

Save

Project Management.

file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/Project/ProjectManagementPartialBundle.html
file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/Project/ProjectManagement.html




Working With Groups

gender::female location::urban family

status::single

Exploring Coded Data

smart group

global filter

Quotation Manager

Application of Document Groups

Video Tutorial: Organizing documents and document groups

https://doc.atlasti.com/ManualWin/Codes/ExploringCodedData.html
https://doc.atlasti.com/ManualWin/Analysis/AnalysisWhatAreSmartGroups.html
https://doc.atlasti.com/ManualWin/Analysis/AnalysisApplyingGlobalFilters.html
https://doc.atlasti.com/ManualWin/Managers/ManagerForQuotations.html
https://youtu.be/IWklmEGiIKs


Code Document

Table

Code Co-occurrence Analysis

https://doc.atlasti.com/ManualWin/CodeDocumentTable/CodeDocumentTable.html
https://doc.atlasti.com/ManualWin/CodeDocumentTable/CodeDocumentTable.html
https://doc.atlasti.com/ManualWin/CodeCooccurrence/CodeCoOccurrenceTools.html


Networks

https://doc.atlasti.com/ManualWin/Networks/NetworksAnalyticFunctions.html


Application of Code Groups



Code Document Table

building a coding system

https://doc.atlasti.com/ManualWin/CodeDocumentTable/CodeDocumentTable.html


Application of Memo Groups

Memos and Comments

Groups as Filters

X

any

https://doc.atlasti.com/ManualWin/Memos/MemosAndComments.html


all



Working with Quotations

Video Tutorial: Working with quotations

The ATLAS.ti Quotation Level

Creating Quotations in Text Documents

Coding Data

Create Free

Quotation

https://youtu.be/luGhMy91LmY


Quotation ID



Changing the Chronological Order of Quotations

Renumber Quotations

Adding Quotation Names

Building a Code

System

Working with Multimedia Data

Rename.

https://doc.atlasti.com/ManualWin/Multimedia/MultimediaWorkingWith.html




Resizing a Quotation





Coding Data - Basic Concepts

“Coding means that we attach labels to 'segments of data' that depict what each segment is

about. Through coding, we raise analytic questions about our data from […]. Coding distills

data, sorts them, and gives us an analytic handle for making comparisons with other

segments of data”

“Coding is the strategy that moves data from diffuse and messy text to organized ideas

about what is going on”

"Coding is a core function in ATLAS.ti that lets you “tell” the software where the interesting

things are in your data. ... the main goal of categorizing your data is to tag things to define or

organize them. In the process of categorization, we compare data segments and look for

similarities. All similar elements can be grouped under the same name. By naming something,

we conceptualize and frame it at the same time"

Independent Code / Category Code / Subcode

independent codes



Independent code:

Free code:

Category Code:

inter-code agreement analysis

https://doc.atlasti.com/ManualWin/ICA/ICARequirementsForCoding.html


Subcode:

How to build a code system

Folder:

How Groundedness is Counted

Independent Code:

Category Code:



inter-code agreement analysis

positive effects

Subcode:

life is richer

Folder:

Experience of

Parenthood

How Density is Counted

code density

networks

https://doc.atlasti.com/ManualWin/ICA/ICARequirementsForCoding.html


Creating and Applying Codes

Video Tutorial: How to code data

Creating New Codes without Coding

Coding Data - Basic Concepts

Importing A List Of Codes

Home New Entities

New Code(s) Ctrl+K

Code Manager.

New Codes

Coding with a New Code

Apply Codes Ctrl+J

https://youtu.be/SivD3Uwf6Ng
file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/Codes/CodeImportExportCodeList.html


Working With Multimedia

Data Working With Geo Docs

Code In-Vivo

https://doc.atlasti.com/ManualWin/Multimedia/MultimediaData.html
https://doc.atlasti.com/ManualWin/Multimedia/MultimediaData.html
https://doc.atlasti.com/ManualWin/Documents/DocumentTypeGeoWorkingWith.html


Working with

Codes > Modifying the length of a coded segment

Code in Vivo

"Over-dependence on in-vivo codes ... 'can limit your ability to transcend to more conceptual

and theoretical levels of analysis and insight' (Saldana, 2009:77). Where they are descriptive

and unique to one person, the coder needs to move on from them quite quickly to generate a

more analytical code."

Display of Coded Data Segments in the Margin Area



Applying Existing Codes

Coding Dialogue Drag & Drop

Using the Coding Dialogue

Apply Codes

Drag-and-Drop Coding

Project Explorer

Code Browser

Code Manager

Drag & Drop Coding from the Code Browser

Home Codes



Working

With Networks

Drag & Drop Coding from the Code Manager

Working With Docked And Floated Windows

Quick Coding

https://doc.atlasti.com/ManualWin/Intro/IntroductionInterfaceSoftwareNavigation.html


Quick Coding

Ctrl+L

Document Ribbon when Coding

Create Free Quotation

Apply Codes:

Code In vivo:

Quick Coding:

Search & Code: Search & Code

Focus Group Coding: Focus Group Coding

AI Coding: AI Coding

Rename:

Delete:

Unlink:

Reverse Link:

Relation:

Comment:

https://doc.atlasti.com/ManualWin/FocusGroups/FocusGroupDataCoding.html
https://doc.atlasti.com/ManualWin/SearchAndCode/AICoding.html


Word Cloud:

Word List:

Concepts: Concept Search

Search Document:

Edit:

Print:

Printer:

Orientation:

Margin space:

Pages:

https://doc.atlasti.com/ManualWin/SearchAndCode/SearchAndCodeFindConcepts.html


print with margin

Keyboard Shortcuts For Coding

Coding Short-Cut

More Drag-And-Drop Options



Working with Codes

Modifying the Length of a Coded Segment

Removing a Coding

In the Margin Area

Unlink



In the Coding Dialogue

Applied Codes

Replacing a Code via Drag & Drop

Adding, Changing and Removing Code Color

Via the ribbon

Change Color

Change Color Remove color

Further Options in Networks.

https://doc.atlasti.com/ManualWin/Networks/NetworksFurtherOptions.html


Via the context menu

Change Color

Importing code lists

file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/Codes/CodeImportExportCodeList.html


Renaming a Code

Rename

Rename

F2

Deleting One or Multiple Code(s)

Delete

About Renaming, Deleting and Unlinking Codes

applied

codings



global

Duplicating a Code

Duplicate Code(s)

Further Options in Networks.

Writing Code Comments

https://doc.atlasti.com/ManualWin/Networks/NetworksFurtherOptions.html


Edit Comment

Edit Comment





Creating Categories and Subcodes

Video Tutorial: Building a code hierarchy

categories

and subcodes

"If you have a typical project of moderate complexity, it should require no more than 10 top-

level [parent] categories" to cover the topic [...]. Furthermore, most code systems do not go

more than two or three levels deep. If they do, it is likely that the categories being used are

no longer true subcategories of the higher-order categories they are under; and, on a

practical level, it becomes inconvenient for the coder to remember, locate, and effectively

use them"

How to build a code system

folders

https://youtu.be/fEJD3SNtmBU


Creating Categories with Subcodes

free

Moving Codes under a Free Code

Build Code Hierarchy





Creating a Category via Splitting

Split into Subcodes

Add Codes

Add

Undecided



Mutually exclusive:

Mutually Exclusive

Requirements for Coding

Split Code.

Creating category and subcodes in the coding dialog

Apply Codes

Adding a category with subcode

https://doc.atlasti.com/ManualWin/ICA/ICARequirementsForCoding.html


Adding a new subcode to an already existing category

Easy coding with subcodes of a category



How to move subcodes out of a category



Organizing Codes in Folders

How to build an effective code system



How to create folders

New Folder

New

Folder with Selection



How to move items between folders or out of a folder



Automatically Code Data

Search & Code

AI Coding

Find Concepts and Auto-code

Text search

Expert search

Named Entity Recognition (NER)

Sentiment Analysis

file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/SearchAndCode/AICoding.html
file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/SearchAndCode/SearchAndCodeFindConcepts.html
file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/SearchAndCode/SearchAndCodeTextSearch.html
file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/SearchAndCode/SearchAndCodeRegularExpressions.html
file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/SearchAndCode/SearchAndCodeNER.html
file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/SearchAndCode/SearchAndCodeSentimentAnalysis.html


Retrieving Coded Data

Video Tutorial: Retrieving coded data

From the Project Explorer, Code Manager or Code Browser

Quotation Reader

Dock to Navigation Area

https://youtu.be/bDUg8pL_H6k
https://doc.atlasti.com/ManualWin/Quotations/QuotationReader.html


Simple Retrieval in the Margin Area

Simple Boolean Queries in The Quotation Manager



Search Code

Show

quotations coded with of ANY of the codes.....

any

ANY ALL



ANY: any

ALL all

Report Excel Export

Creating Reports

https://doc.atlasti.com/ManualWin/Reports/Reports.html


Merging Codes

Video Tutorial:

Merge code ... into ...





Merge Codes

Merge

Merge Codes



Networks: Further Options

https://doc.atlasti.com/ManualWin/Networks/NetworksFurtherOptions.html


Splitting a Code

"Inevitably, not all codes you produce will continue to prove useful. Some will be too general,

others too specific to one or two segments of data (see Merging Codes). With the exception

of contextual codes, a category that is so broad or so vaguely defined that it codes a very

large number of passages or very lengthy passages is less likely to be useful in analysis"

Splitting a code into independent codes

Split

Code

Split



New Codes

Create



Split Code

Options

Copy Comments:

Copy links:

Mutually exclusive:

Mutually Exclusive Coding

Mutually Exclusive

Requirements for Coding

https://doc.atlasti.com/ManualWin/ICA/ICARequirementsForCoding.html


Splitting a code into a category and subcodes

Split into Subcodes

New Codes

Create

Undecided



Mutually exclusive:

Mutually Exclusive

Requirements for Coding

Split Code.

https://doc.atlasti.com/ManualWin/ICA/ICARequirementsForCoding.html


Building a Code System

How to Begin Building a Code System

merged split



Further Data Analysis

https://doc.atlasti.com/ManualWin/Querying/QueryingData.html


document groups





Characteristics of a well-structured code list

Code Co-occurrence Table

Good Practice Tips

The Role of Code Groups in Building a Code System

https://doc.atlasti.com/ManualWin/CodeCooccurrence/CodeCoOccurrenceTable.html


Moving on

code co-occurrence table code document table query tool networks

memos

reading the data resulting from a query

Literature

Qualitative Data Analysis: Practical Strategies.

Analysing Qualitative Data: Systematic Approaches.

Qualitative Research for education: An introduction to theory

and methods (2nd ed.).

Constructing Grounded Theory: A Practical Guide Through

Qualitative Analysis.

Basics of Qualitative Research:

Techniques and Procedures for Developing Grounded Theory.

Modes of Thinking for Qualitative Data Analysis.

Qualitative Data Analysis with ATLAS.ti.

Analysing Qualitative Data.

Applied Thematic Analysis.

Applied Thematic Analysis.

Ethnography: Principles in Practice.

International Journal of Social Research Methodology

https://doc.atlasti.com/ManualWin/CodeCooccurrence/CodeCoOccurrenceTable.html
https://doc.atlasti.com/ManualWin/CodeDocumentTable/CodeDocumentTable.html
https://doc.atlasti.com/ManualWin/Querying/QueryTool.html
https://doc.atlasti.com/ManualWin/Networks/NetworksAnalyticFunctions.html
https://doc.atlasti.com/ManualWin/Memos/MemosAndComments.html
https://doc.atlasti.com/ManualWin/Quotations/QuotationReader.html


Qualitative Data Analysis.

Readme first: for a user’s guide to Qualitative Methods.

Handling qualitative data: A practical guide.

The Coding Manual for Qualitative Researchers.

The Ethnographic Interview.

Qualitative analysis for social scientists.

Qualitative

Sociology,



Creating a Codebook

Export Codebook

Excel Export

Example Outcome:





Working with Memos and Comments

Video Tutorial: Using memos at project begin

"Memos and diagrams are more than just repositories of thoughts. They are working and

living documents. When an analyst sits down to write a memo or do a diagram, a certain

degree of analysis occurs. The very act of writing memos and doing diagrams forces the

analyst to think about the data. And it is in thinking that analysis occurs"

"Writing is thinking. It is natural to believe that you need to be clear in your mind what you

are trying to express first before you can write it down. However, most of the time, the

opposite is true. You may think you have a clear idea, but it is only when you write it down

that you can be certain that you do (or sadly, sometimes, that you do not)"

report writing

Theory-building

Differences between Memos and Comments

Quotation comment

https://youtu.be/Fn0DO0QKExk


Code comment

Memos





Creating Memos

Home Memo Manager

Home

New Entities Free Memo

Create

Interface Navigation

Memo Manager

Create Free Memo

Create

Save

https://doc.atlasti.com/ManualWin/Intro/IntroductionInterfaceSoftwareNavigation.html


Linking Memos

Linking Nodes

Reviewing Quotations Linked to a Memo

Ctrl key + double-

click

Opening an Existing Memo

Writing a Comment

Entity Manager

Save

Edit Comment

https://doc.atlasti.com/ManualWin/Managers/EntityManagers.html


References



Querying Data

Simple Boolean Retrieval.

Retrieving Coded Data.

Code Document Table

Code Document Table.

Co-occurrence Analysis

Code Co-Occurrence Table.

https://doc.atlasti.com/ManualWin/CodeDocumentTable/CodeDocumentTableQuickTour.html
https://doc.atlasti.com/ManualWin/CodeCooccurrence/CodeCoOccurrenceTableQuickTour.html


The Query Tool



Smart Codes



Smart Groups

Global Filters





ATLAS.ti Networks

Video utorial: Visualizations in Building the Understanding

network

nodes links

https://youtu.be/P6AlJxTaXvI


Basic Network Procedures

Creating a New Network

New Entities New

Networks

Create

Networks New

Network

Adding Nodes to a Network

Add Nodes

Adding Nodes Using the Selection List

Nodes Add Nodes



Adding Nodes Using the Selection List

Nodes Add Nodes



Add

Adding Nodes via Drag & Drop

Selecting Nodes

Selecting a Single Node



Selecting Multiple Nodes

Method 1

Ctrl

Method 2



Linking Nodes and Entities

Linking via Drag & Drop



New Relation Type create a new

relation

Linking Two Nodes Using the Ribbon Icon

Link

Density

file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/Networks/NetworksCreatingNewRelations.html
file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/Networks/NetworksCreatingNewRelations.html


Linking Three or More Nodes

Basis Network

Procedures > Selecting Nodes

Link

Editing a Link

Open Network:

Edit Comment:

Flip Link: transitive or asymmetric

link.

Cut Link:

Change Relation:

file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/Networks/NetworksAboutRelations.html
file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/Networks/NetworksAboutRelations.html


cut link



Cutting Multiple Links

Cut Links

Linking Codes to Codes, Quotations to Quotations, Memos to
Memos in Managers and Browsers

New Relation Type create a new relation.

file:///home/devops/myagent/_work/_temp/SSDb29843/PDF/Networks/NetworksCreatingNewRelations.html


Linking Entities of Different Types



Creating Reports

Export as Spreadsheet

From Managers

Export as Spreadsheet.

From the Quotation Reader

options button Export as

Spreadsheet.



From the Query Tool

Export as Spreadsheet.

Export as Report

Export as Report.

Filter:

Grouping:



Report options:

Save:

Print:



Appendix

System Requirements

Useful Resources:

Get In Touch

System Requirements

Hardware:

Operating systems:



Useful Resources

ATLAS.ti Welcome Screen

The ATLAS.ti Website

https://atlasti.com/

Getting Support

https://support.atlasti.com

Help > Online Resources / Contact Support

Video Tutorials

ATLAS.ti Video Tutorials

Sample Projects

website

https://doc.atlasti.com/ManualWin/Intro/IntroductionStartingATLAS.tiWelcomeScreen.html
https://atlasti.com/
https://support.atlasti.com/
https://atlasti.com/video-tutorials
https://atlasti.com/sample-projects


PDF Manuals

ATLAS.ti Full Manual and other documentations.

Research Blog

The ATLAS.ti Research Blog

contact us

Inter-coder Agreement in ATLAS.ti by Prof. Krippendorff

multi-valued

coding. an article written by Prof. Krippendorff

Publications

https://atlasti.com/manuals-docs/
https://atlasti.com/research-hub
mailto:training@atlasti.com
https://doc.atlasti.com/ManualWin/ICA/ICARequirementsForCoding.html
https://doc.atlasti.com/ManualWin/ICA/ICARequirementsForCoding.html
https://atlasti.com/home/intercoder-agreement-with-atlas.ti-by-prof.-krippendorff.pdf


Carrying out a computer-aided

thematic content analysis with ATLAS.ti. MMG Working Paper 18-0.

CAQDAS and Grounded Theory Analysis. Working Papers WP 16-07

Qualitative Social Network Analysis with

ATLAS.ti: Increasing power in a blackcommunity.

Making Thinking Visible with Atlas.ti: Computer Assisted Qualitative

Analysis as Textual Practices. Forum Qualitative Sozialforschung / Forum: Qualitative Social

Research, 9(2).

https://www.mmg.mpg.de/62142/WP_18-02_Friese-Soratto-Pires_AtlasTI.pdf
https://www.mmg.mpg.de/62142/WP_18-02_Friese-Soratto-Pires_AtlasTI.pdf
https://www.mmg.mpg.de/61773/WP_16-07_Friese-Theory-Analysis.pdf
https://depositonce.tu-berlin.de/handle/11303/5484
https://depositonce.tu-berlin.de/handle/11303/5484
https://doi.org/10.17169/fqs-9.2.420
https://doi.org/10.17169/fqs-9.2.420
https://doi.org/10.17169/fqs-9.2.420


Get In Touch

Social Media

Help > Social Media.

Twitter

Facebook

Instagram

LinkedIn

YouTube channel

https://twitter.com/ATLASti
https://www.facebook.com/ATLAS.ti
https://www.instagram.com/atlas.ti_qdasoftware/
https://www.linkedin.com/in/atlas-ti-gmbh-03249489/
https://www.youtube.com/user/ATLASti01
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